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Operating Instructions
(For PostScript3 Printer Driver)

Model No. DP-C262/C322

Before using this software, please read these instructions completely and keep these operating instructions for future reference.
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The following trademarks and registered trademarks are used throughout this manual:

Microsoft, MS-DOS, Windows, Windows NT and Windows Server are either registered 
trademarks or trademarks of Microsoft Corporation in the USA and other countries.
i386, i486, Celeron, Intel Centrino and Pentium are trademarks of Intel Corporation.
The USB-IF Logos are trademarks of Universal Serial Bus Implementers Forum, Inc.
TrueType is a registered trademark of Apple Computer, Inc.
Novell, NetWare, IntranetWare, NDS are registered trademarks of Novell, Inc. in the USA and 
other countries.
PEERLESSPage™ is a trademark of the PEERLESS Systems Corporation; and,
PEERLESSPrint and Memory Reduction Technology® are registered trademarks PEERLESS
Systems Corporation; and, COPYRIGHT © 2005 PEERLESS Systems Corporation.
COPYRIGHT © 2005 Adobe Systems Incorporated. All Rights Reserved; and Adobe®

PostScript® 3™
Universal Font Scaling Technology (UFST) and all typefaces have been licensed from Agfa  
Monotype.
Agfa® and the Agfa rhombus are registered trademarks of Agfa-Gevaert N.V. registered in the 
U.S. Patent and Trademark Office and may be registered in other jurisdictions. Monotype® is a 
registered trademark of AMT registered in the U.S. Patent and Trademark Office and may be 
registered in other jurisdictions.
ColorTune® is a registered trademark of Agfa-Gevaert N.V. registered in the U.S. Patent and 
Trademark Office and may be registered in other jurisdictions. Profile Tool Kit™, Profile Studio™ 
and Profile Optimizer™ are trademarks of AMT and may be registered in certain jurisdictions.
PCL is a trademark of Hewlett-Packard Company.
Adobe, Acrobat, Adobe Reader, Adobe Type Manager, PostScript, PostScript 3 and Reader are 
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 
and/or other countries.
All other product/brand names, trademarks or registered trademarks identified herein are the 
property of their respective owners.

©  2005 Panasonic Communications Co., Ltd. All Rights Reserved.
Unauthorized copying and distribution is a violation of law.
Published in Japan.

The contents of these Operating Instructions are subject to change without notice.
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The PostScript (PS) Printer Driver is required to send Adobe® PostScript® 3™ print data from a PC to your 
machine.
The properties window of the PS Printer Driver can be used to specify print settings, such as the print orientation 
and page size. The PS Printer Driver also provides a range of easy-to-use layout functions that allow you to 
setup printing to suit your requirements.

 The PS Printer Driver is the base software required to send print data to your machine as a network printer or 
local printer.

Ethernet / AppleTalkEthernet / AppleTalk

 Network Printer Port adds a new port to your Windows PC in accordance with the type of network (LPR, IPP, 
or Raw mode) that you are using. Once you have installed the Network Printer Port on your Windows PC, 
setting up your network printer is easy.

NetworkNetwork

NOTE The DP-C262/C322 supports both the Printer Control Language (PCL), and PostScript (PS) printing.
The PCL Printer Driver is required if using as a PCL printer.
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Opening the Printer Properties Dialog Box
To change the printer settings, open the dialog box for the printer properties by performing the following steps.

Click the Start button, select Settings, and then click Printers.

Right-click on the printer icon in the Printers folder, and then select Properties in the pop-up menu.

The following printer properties dialog box appears. Click the desired tab(s) and configure the properties as 
necessary.
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General / Details / Color Management / Sharing / Fonts / PostScript / Watermarks Tab:
These tabs are Windows specific settings. Refer to Windows manuals, Windows pop-up help topics, and/or 
Online Support.

Note:
To open Windows pop-up help topics:
 Click the ?  icon at top right corner of the printer properties dialog box. The "?" mark will appear on your mouse cursor.
 Then click on unfamiliar object in the dialog box, the topic opens in a pop-up window. When you finish reading the 

information in the pop-up window, you can close it by clicking anywhere in the window.

Paper / Graphics / Device Options Tab:
These tabs are Panasonic Printing System associated settings. For additional details, refer to the page(s) 
relevant to the subject you are interested in.

Device Options Tab : see page 14

Graphics Tab : see page 12

Paper Tab : see page 10
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Paper Tab
Paper tab is used for configuring output paper settings.

1

3

2

4

5

6

7

8

9
10

1. Paper size
 Specifies the form-to-tray assignment. Once 

you have assigned a form to a specific tray, 
the printer will always use that tray to print the 
defined paper size (form).

2. Orientation
 Specifies the direction of the image to be printed 

(Portrait/Landscape).

3. Paper control
 Controls printer outputs and groups pages.
 Select Collate if you wish each set of multiple 

copies collated when you print them. Otherwise, 
each page is printed in individual groups.

 The Duplex menu specifies whether and how 
the printer should print the document on both 
sides of the paper.
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4. Paper source
 Specify the paper tray you would like to use. If you choose AutoSelect Tray, the printer driver will 

automatically select an appropriate tray according to the Paper size selected.

5. Output bin
 Specifies the output tray.

6. Paper type
Specifies the type of paper.

Note:
 Verify that the paper type selection in the control panel matches the media loaded on the trays. 
(Ex: Select "Transparency" when Transparencies are loaded in the Sheet Bypass)

 Transparency is only available if the selected Paper Size is A4 or Letter.
 Envelope is only available if one of the envelope paper sizes is selected.
 If the Paper Type is other than Plain Paper, Glossy/Photo Paper or Recycled Paper, then the Multi-Purpose 
Tray is the only selectable in Paper Source.

7. Margins...  button
 Displays the Margins dialog box. Click this button to view the area of the page that is unavailable for 

printing.

8. About...  button
 Displays version and copyright information for this printer driver.

9. Help  button
 Displays the help window for this printer driver.

10. Restore Defaults  button
 Sets the values of all options in the current dialog box to the default values specified in the PPD file.

Automatically Select Automatically selects one of the following output trays.

Inner Tray Sends printed jobs to the inner tray.

Outer Tray Sends printed jobs to the outer tray. (Selection only displays if the printer is 
equipped with an outer tray)

Finisher Sends printed jobs to the finisher. (Selection only displays if the printer is equipped 
with a finisher)



Graphics Tab
Graphics tab configures the settings that determine the print quality.
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1

3

2

4

5

6

1. Resolution
Specifies the printing resolution. Choosing a 
higher resolution improves the print quality but 
slows printing.

Note:
 Printing takes twice as long when Enhance is 
selected.

 When the Paper type is Transparency, the quality 
is automatically set to Standard.

 Enhance is not available unless the 512MB optional 
printer memory is installed.Standard

Enhance Prints at a print engine resolution 
of 1200×1200 dpi.

Prints at a print engine resolution 
of 600×600 dpi.
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2. Special
 Prints a negative image and/or mirror image of 

your document. Click these options to view an 
example.

3. Paper handling
 Specify the layout pattern for printing multiple 

documents on a single sheet of paper and 
whether page borders are used. Select these 
options to view an example.

4. Scaling (25-400%)
 Specify an enlargement or reduction 

percentage when printing documents. If 
enlargement/reduction can be set within the 
application software, indicate 100% here and 
specify the enlargement/reduction percentage in 
the Print dialog box of the application software.

5. Convert gray text / graphics to PostScript 
gray

 This feature is not available on these machines.

6. Help  button
 Displays the help window for this printer driver.

7. Restore Defaults  button
 Sets the values of all options in the current dialog 

box to the default values specified in the PPD 
file.
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Device Options Tab
Device Options tab is used for configuring Panasonic Printing System associated settings.

1

3

2

4

5 6

1. Available printer memory
 Specifies the amount of available printer memory. The driver uses this information when performing printing 

tasks, such as sending fonts from the computer to the printer.

2. Available font cache
 Displays the amount of font cache memory now available to Type 32 fonts (bitmap font format). The Driver 

automatically adjusts the font cache size according to the installed memory option selected in the Installable 
options box.
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3. Printer features

Sort

Punch

Note:

Staple

Note:

Note:

Number of Paper Trays
Specifies the number of paper trays installed on 
the device.

HDD Unit
Select Installed if a hard disk drive is installed.

4.
Specifies the following printer settings:
Installable options

Finisher
If the printer is equipped with a Finisher, select it 
from the list.

Punch Unit
Select Installed if a Punch Unit is installed.

Non Sort Print individual pages in the specified quantity. For example, if you print three copies of 
a five-page document, the printer prints page 1 three times before printing page 2 and 
so on.

Sort Copies are stacked in the order they are printed. Multiple copies are printed in 
separate sets in the specified quantity. For example, if you print three copies of a 
five-page document, the printer prints pages 1-5 three times.

Rotate Stack Each set is rotated and stacked uniformly.

Rotate Sort Each set is rotated and sorted.

Shift Stack Each set is shifted and stacked uniformly.

Shift Sort Each set is shifted and sorted.

 Shift is available only if the printer is equipped with a finisher.
 Rotate is available only when Output bin is set to Automatically Select within the Paper tab.
 Rotate requires paper of the specified size to be loaded in two trays, loaded for landscape and portrait printing.

 Only available if the printer is equipped with an 
optional finisher.

 Available staple position may be different 
depending on the finishers.

 The staple capacity differ depending on the 
types of finisher and the paper size. (i.e. up to 
50 sheets, Letter or A4 size, 1-Bin Saddle Stitch 
Finisher) Refer to Specifications in the Operating 
Instructions (For Basic Function) provided another 
booklet.

 When setting the staple position to Saddle Stitch, 
set paper in Landscape position.

Specifies the position of the staple. Choose the 
position from Left 1, Left 2, Right 1, Right 2, 
Top 2 or Saddle Stitch.

 Only available if the printer is equipped with an 
optional finisher and puncher unit.
Hole punching can be performed on the following 
paper sizes.
A3, A4, B4(JIS), B5(JIS), Ledger, Legal, Letter 
and FLS2

Specifies the hole punch position.

Specifies how pages are sorted when multiple copies are printed.

Specifies the following printer settings:

5. Help  button
 Displays the help window for this printer driver.

6. Restore Defaults  button
 Sets the values of all options in the current dialog 

box to the default values specified in the PPD file.
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Opening the Printing Preferences Dialog Box
To change the printer settings, open the dialog box for the printer properties by performing the following steps.

Click the Start button, select Printers and Faxes icon. (for Windows NT 4.0 / 2000: Click the Start button, 
select Settings, and then click the Printers icon)

Right-click on the desired printer icon in the Printer and Faxes folder, and then select Printing 
Preferences... in the pop-up menu.
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The Printing Preferences (For Windows NT: Default Properties dialog box) dialog box appears.

For Windows NT : Select the Advanced tab.

For Windows XP / 2000 : Click the Advanced...  button.

The following Advanced Settings dialog box appears. Click the desired item(s) and configure the properties 
as necessary.

Windows XP / 2000
Windows NT 4.0
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Advanced Settings
In the Advanced Settings dialog box, following items are Panasonic Printing System associated settings.

Graphic - Print Quality
Specifies the printing resolution. Choosing a higher resolution improves the print quality but slows printing.

Automatically Select Automatically selects one of the following output trays.

Inner Tray Sends printed jobs to the inner tray.

Outer Tray Sends printed jobs to the outer tray. (Selection only displays if the printer is equipped 
with an outer tray)

Finisher Sends printed jobs to the finisher. (Selection only displays if the printer is equipped 
with a finisher)

Standard Prints at a print engine resolution of 600×600 dpi.

Enhance Prints at a print engine resolution of 1200×1200 dpi.

Note:
 Printing takes twice as long when Enhance is selected.
 When the Media type is Transparency, the quality is automatically set to Standard.
 Enhance is not available unless the 512MB optional printer memory is installed.

Printer Features - Finisher Bin
Specifies the output tray.

Printer Features - Sort
Specifies how pages are sorted when multiple copies are printed.

Non Sort

Sort

Rotate Stack
Rotate Sort
Shift Stack
Shift Sort

Print individual pages in the specified quantity. For example, if you print three copies of a 
five-page document, the printer prints page 1 three times before printing page 2 and so on.
Copies are stacked in the order they are printed. Multiple copies are printed in separate sets 
in the specified quantity. For example, if you print three copies of a five-page document, the 
printer prints pages 1-5 three times.

Each set is rotated and stacked uniformly.

Each set is rotated and sorted.

Each set is shifted and stacked uniformly.

Each set is shifted and sorted.

Note:
 Shift is available only if the printer is equipped with a finisher.
 Rotate is available only when Paper Source is set to Automatically Select.
 Rotate requires paper of the specified size to be loaded in two trays, loaded for landscape and portrait printing.
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Printer Features - Punch
Specifies the hole punch position.

Note:
 Only available if the printer is equipped with an optional finisher and puncher unit.
 Hole punching can be performed on the following paper sizes.
 A3, A4, B4(JIS), B5(JIS), Ledger, Legal, Letter and FLS2

Printer Features - Color Mode
Specifies whether to print in color or grayscale.

Color
Photo Color
Grayscale

Prints documents in color.

Prints photos with the optimal settings.

Prints documents in monochrome.

Note:
Photo Color mode takes more time to print a file.

Printer Features - Color Management
Specifies color settings to fine-tune color reproduction.

Device Color
None
SWOP
Euroscale

Choose this option to adjust the original color settings.

Select None when using ICM or application's color management.

Simulates printing to a standard American offset press.

Simulates printing to an European offset press.

Printer Features - Device Color Space for Text / Graphics / Image
Specifies color reproduction and black output for text, graphics and images.

Standard Profile 
with Black Gray
Vivid Profile with 
Black Gray
Standard Profile 
with CMYK Gray

Print with color reproduction close to standard color monitors. Use only black to 
reproduce intermediate shades of gray.
Print with more vivid color reproduction. A good choice for line art and graphics. 
Use only black to reproduce intermediate shades of gray.
Print with color reproduction close to standard color monitors. Use the four colors 
of CMYK to reproduce intermediate shades of gray.

Vivid Profile with 
CMYK Gray

Print with more vivid color reproduction. A good choice for line art and graphics. 
Use the four colors of CMYK to reproduce intermediate shades of gray.

Printer Features - Staple
Specifies the position of the staple. Choose the position from Left 1, Left 2, Right 1, Right 2, Top 2 or Saddle 
Stitch.

Note:
 Only available if the printer is equipped with an optional finisher.
 Available staple position may be different depending on the finishers.
 The staple capacity differ depending on the types of finisher and the paper size. (i.e. up to 50 sheets, Letter or 
A4 size, 1-Bin Saddle Stitch Finisher) Refer to Specifications in the Operating Instructions (For Basic Function) 
provided another booklet.

 When setting the staple position to Saddle Stitch, set paper in Landscape position.
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Printer Features - Toner Save
Choose On to conserve toner. The overall effect is lighter, so this feature is recommended for test printing or 
producing documents for which appearance is not critical.

Printer Features - Brightness
Color brightness is adjustable. 100% is normal brightness. Brightness darkens as the numerical value grows.

Printer Features - Secure
Printed documents can be saved on the printer's optional hard disk drive (HDD) if the printer is equipped with 
one. Saved documents can be printed from the printer's control panel. See "Mailbox Printing" on page 47. Three 
types of mailbox printing is available.

None
Check Then Print

Mailbox

Secure Mailbox

Mailbox printing is not applied.

Allows you to print one proof set, before proceeding to print a large multi-set with 
various settings. The documents data will be deleted from the printer after printing.
Saves print data in the printer, in the mailbox specified by the User ID. The User ID 
must be entered to print documents saved in Mailbox. The document data will remain in 
the printer until it is deleted.

Saves print data in the printer, in the mailbox specified by the User ID. The User ID and 
Password must be entered to print confidential documents saved in Secure Mailbox. 
The document data will remain in the printer until it is deleted.

Note:
Using mailbox printing requires that the optional Hard Disk Drive Unit is installed in the printer.

Printer Features - Print Blank Pages
Selecting this option will enable printing blank pages.

Note:
The Print Blank Pages is not selectable if the Print on Both Sides is set to be enabled on the Layout menu.

Printer Features - Front/Back Cover
You can configure the settings for cover pages. To use a cover page, select Front Cover or Back Cover, 
specifies the paper source used for pages for the Front and Back covers.
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Device Settings
Device Settings dialog box include the options settings of Panasonic printer. To change the Device Settings, 
open the dialog box for the printer properties by performing the following steps.

Logon to the computer/network using an account with administrator rights.

Click the Start button, select Printers and Faxes icon. (for Windows NT 4.0 / 2000: Click the Start button, 
select Settings, and then click the Printers icon)

Right-click on the desired printer icon in the Printer and Faxes folder, and then select Properties in the 
pop-up menu.

Select Device Settings tab.

Specifies the following printer settings within the Installable options:

Number of Paper Tray
Specifies the number of paper trays installed on the device.

HDD Unit
Select Installed if a hard disk drive is installed.

Finisher
If the printer is equipped with a Finisher, select it from the list.

Punch Unit
Select Installed if a Punch Unit is installed.

Click the OK  button.

Windows XP Windows NT 4.0 / 2000 Windows 98 / Me
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Opening the Print Dialog Box
To change the printer settings, open the dialog box for the printer properties by performing the following steps.

Select the File menu > Print.

Select the Panasonic printer.

In the print dialog box, you will see a number of titles in the pop-up menu. Select the desired menu title(s) 
and configure the properties as necessary. Click the Save Settings  button to save the current settings for 
the default values.

General / Background Printing / Cover Page / Color Matching / Layout / Error Handling / PostScript 
Settings menus:

These menus are Macintosh or Adobe PostScript specific settings. Refer to Macintosh manuals, help 
topics, and/or Online Support.
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Output / Quality / Printer Specific Options menus:

These menus are Panasonic Printing System associated settings. For additional details, refer to the 
page(s) relevant to the subject you are interested in.

Quality menu : see page 26

Output menu : see page 24

Printer Specific Options menu : see page 28
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Output Menu
Output menu is used for configuring output settings.

1

3

2

4

5

1. Collation
 This feature is not available on these machines.

Specifies the output tray.
Finisher Bin2.

Automatically Select
Inner Tray
Outer Tray

Finisher

Automatically selects one of the following output trays.

Sends printed jobs to the inner tray.

Sends printed jobs to the outer tray. (Selection only displays if the printer is 
equipped with an outer tray)
Sends printed jobs to the finisher. (Selection only displays if the printer is 
equipped with a finisher)
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5. Punch
Specifies the hole punch position.

Note:
 Only available if the printer is equipped with an optional finisher and puncher unit.
 Hole punching can be performed on the following paper sizes.
 A3, A4, B4(JIS), B5(JIS), Ledger, Legal, Letter and FLS2

4. Staple

Note:
 Only available if the printer is equipped with an optional finisher.
 Available staple position may be different depending on the finishers.
 The staple capacity differ depending on the types of finisher and the paper size. (i.e. up to 50 sheets, Letter or 
A4 size, 1-Bin Saddle Stitch Finisher) Refer to Specifications in the Operating Instructions (For Basic Function) 
provided another booklet.

 When setting the staple position to Saddle Stitch, set paper in Landscape position.

Specifies the position of the staple. Choose the position from Left 1, Left 2, Right 1, Right 2, Top 2 or 
Saddle Stitch.

Note:
 Shift is available only if the printer is equipped with a finisher.
 Rotate is available only when Paper Source is set to Automatically Select.
 Rotate requires paper of the specified size to be loaded in two trays, loaded for landscape and portrait printing.

Non Sort

Sort

Rotate Stack
Rotate Sort
Shift Stack
Shift Sort

Print individual pages in the specified quantity. For example, if you print three 
copies of a five-page document, the printer prints page 1 three times before 
printing page 2 and so on.

Copies are stacked in the order they are printed. Multiple copies are printed in 
separate sets in the specified quantity. For example, if you print three copies of a 
five-page document, the printer prints pages 1-5 three times.

Each set is rotated and stacked uniformly.

Each set is rotated and sorted.

Each set is shifted and stacked uniformly.

Each set is shifted and sorted.

Specifies how pages are sorted when multiple copies are printed.
Sort3.
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Quality Menu
Quality menu configures the settings that determine the print quality.

1

3

2

4

5

6

Media Type1.

Specifies the type of paper.

Note:
 Verify that the media type selection in the control panel matches the media loaded on the trays. (Ex: Select 
"Transparency" when Transparencies are loaded in the Sheet Bypass)

 Transparency is only available if the selected Paper Size is A4 or Letter.
 Envelope is only available if one of the envelope paper sizes is selected.
 If the Media Type is other than Plain Paper, Glossy/Photo Paper or Recycled Paper, then the Multi-Purpose 
Tray is the only selectable Paper Source within the General menu.

Specifies the printing resolution. Choosing a higher resolution improves the print quality but slows printing.

Standard Prints at a print engine resolution of 600×600 dpi.

Enhance Prints at a print engine resolution of 1200×1200 dpi.

Note:
 Printing takes twice as long when Enhance is selected.
 When the Media Type is Transparency, the quality is automatically set to Standard.
 Enhance is not available unless the 512MB optional printer memory is installed.

Resolution2.
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Note:
Photo Color mode takes more time to print a file.

Specifies whether to print in color or grayscale.

Color
Photo Color
Grayscale

Prints documents in color.

Prints photos with the optimal settings.

Prints documents in monochrome.

Color Mode3.

Device Color
None
SWOP
Euroscale

Choose this option to adjust the original color settings.

Select None when using ICM or application's color management.

Simulates printing to a standard American offset press.

Simulates printing to an European offset press.

Specifies color settings to fine-tune color reproduction.
Color Management4.

Standard Profile 
with Black Gray

Vivid Profile with 
Black Gray

Standard Profile 
with CMYK Gray

Vivid Profile with 
CMYK Gray

Print with color reproduction close to standard color monitors. Use only Black to 
reproduce intermediate shades of gray.

Print with more vivid color reproduction. A good choice for line art and graphics. 
Use only Black to reproduce intermediate shades of gray.

Print with color reproduction close to standard color monitors. Use the four colors 
of CMYK to reproduce intermediate shades of gray.

Print with more vivid color reproduction. A good choice for line art and graphics. 
Use the four colors of CMYK to reproduce intermediate shades of gray.

Specifies color reproduction and black output for text, graphics and images.
Device Color Space for Text / Graphics / Image5.

6. Toner Save

 Choose On to conserve toner. The overall effect is lighter, so this feature is recommended for test printing or 

producing documents for which appearance is not critical.
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Printer Specific Options Menu
Printer Specific Options menu is used for configuring Panasonic Printing System associated settings.

1

3

2

Note:
 Using mailbox printing requires that the optional Hard Disk Drive Unit is installed in the printer.
 In order to utilize the mailbox function of the Panasonic printer, the user information must be input prior to installing 

the PS printer driver. The PS Driver Security Utility to change the setting before installing the PS printer driver. For 
more detail, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)".

Printed documents can be saved on the printer's optional hard disk drive (HDD) if the printer is equipped 
with one. Saved documents can be printed from the printer's control panel. See "Mailbox Printing" on page 
47. Three types of mailbox printing is available.

None
Check then Print

Mailbox

Mailbox printing is not applied.

Allows you to print one proof set, before proceeding to print a large multi-set with 
various settings. The documents data will be deleted from the printer after printing.
Saves print data in the printer, in the mailbox specified by the User ID. The User 
ID must be entered to print documents saved in Mailbox. The document data will 
remain in the printer until it is deleted.

Secure Mailbox Saves print data in the printer, in the mailbox specified by the User ID. The User 
ID and Password must be entered to print confidential documents saved in Secure 
Mailbox. The document data will remain in the printer until it is deleted.

Secure1.
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Note:
The Print Blank Pages is not selectable if the Pages per sheet or Print on Both Sides is set to be enabled on the 
Layout menu.

Print Blank Pages
Choose On to enable printing blank pages.

2.

3. Front / Back Cover

 You can configure the settings for cover pages. To use a cover page, select Front Cover or Back Cover, 

specifies the paper source used for pages for the Front and Back covers.
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Opening the Print Dialog Box
To change the printer settings, open the dialog box for the printer properties by performing the following steps.

Select the File menu > Print.

Select the Panasonic printer.
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In the print dialog box, you will see a number of titles in the pop-up menu. Select the desired menu title(s) 
and configure the properties as necessary. Select Save Custom Setting menu to save the current settings 
for the default values.

Copies & Pages / Layout / Output Options / Scheduler / Paper Handling / ColorSync / Cover Page / 
Error Handling / Paper Feed / Summary menus:

These menus are Macintosh or Adobe PostScript specific settings. Refer to Macintosh manuals, help 
topics, and/or Online Support.

Printer Features menu:

There are four kinds of Feature Sets in the Printer Features menu. These are Panasonic Printing System 
associated settings. For additional details, refer to the page(s) relevant to the subject you are interested in.

Output menu : see page 32
Quality_1 menu : see page 34
Quality_2 menu : see page 36
Miscellaneous menu : see page 37
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Output Menu (in Printer Features Menu)
Output menu is used for configuring output settings.

1

3

2

4

Specifies the output tray.

Automatically Select
Inner Tray
Outer Tray

Finisher

Automatically selects one of the following output trays.

Sends printed jobs to the inner tray.

Sends printed jobs to the outer tray. (Selection only displays if the printer is 
equipped with an outer tray)
Sends printed jobs to the finisher. (Selection only displays if the printer is 
equipped with a finisher)

Finisher Bin1.
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Sort2.

Note:
 Shift is available only if the printer is equipped with a finisher.
 Rotate is available only when Paper Source is set to Automatically Select.
 Rotate requires paper of the specified size to be loaded in two trays, loaded for landscape and portrait printing.

Non Sort

Sort

Rotate Stack

Print individual pages in the specified quantity. For example, if you print three 
copies of a five-page document, the printer prints page 1 three times before printing 
page 2 and so on.

Copies are stacked in the order they are printed. Multiple copies are printed in 
separate sets in the specified quantity. For example, if you print three copies of a 
five-page document, the printer prints pages 1-5 three times.

Each set is rotated and stacked uniformly.

Rotate Sort Each set is rotated and sorted.

Shift Stack Each set is shifted and stacked uniformly.

Shift Sort Each set is shifted and sorted.

Specifies how pages are sorted when multiple copies are printed.

Note:
 Only available if the printer is equipped with an optional finisher.
 Available staple position may be different depending on the finishers.
 The staple capacity differ depending on the types of finisher and the paper size. (i.e. up to 50 sheets, Letter or A4 
size, 1-Bin Saddle Stitch Finisher) Refer to Specifications in the Operating Instructions (For Basic Function) provided 
another booklet.

 When setting the staple position to Saddle Stitch, set paper in Landscape position.

Staple
Specifies the position of the staple. Choose the position from Left 1, Left 2, Right 1, Right 2, Top 2 or Saddle 

Stitch.

3.

Note:
 Only available if the printer is equipped with an optional finisher and puncher unit.
 Hole punching can be performed on the following paper sizes.
 A3, A4, B4(JIS), B5(JIS), Ledger, Legal, Letter and FLS2

Specifies the hole punch position.
Punch4.
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Quality_1 Menu (in Printer Features Menu)
Quality_1 menu configures the settings that determine the print quality.

1

3

2

4

Specifies the type of paper.

Note:
 Verify that the media type selection in the control 
panel matches the media loaded on the trays. (Ex: 
Select "Transparency" when Transparencies are 
loaded in the Sheet Bypass)

 Transparency is only available if the selected Paper 
Size is A4 or Letter.

 Envelope is only available if one of the envelope 
paper sizes is selected.

 If the Media Type is other than Plain Paper, 
Glossy/Photo Paper or Recycled Paper, then the 
Multi-Purpose Tray is the only selectable Paper 
Source within the General menu.

Media Type1. Resolution
Specifies the printing resolution. Choosing a 
higher resolution improves the print quality but 
slows printing.

Standard Prints at a print engine resolution 
of 600×600 dpi.

Enhance Prints at a print engine resolution 
of 1200×1200 dpi.

Note:
 Printing takes twice as long when Enhance is 
selected.

 When the Media Type is Transparency, the quality 
is automatically set to Standard.

 Enhance is not available unless the 512MB optional 
printer memory is installed.

2.
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Specifies whether to print in color or grayscale.

Color Prints documents in color.

Photo Color Prints photos with the optimal 
settings.

Grayscale Prints documents in 
monochrome.

Note:
Photo Color mode takes more time to print a file.

Color Mode3.

Specifies color settings to fine-tune color 
reproduction.

Color Management4.

     Device Color

None

SWOP

Euroscale

Choose this option to adjust 
the original color settings.
Select None when using 
ICM or application's color 
management.

Simulates printing to a standard 
American offset press.
Simulates printing to an 
European offset press.
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Quality_2 Menu (in Printer Features Menu)
Quality_2 menu configures the settings that determine the print quality.

1

3

2

Standard Profile 
with Black Gray

Vivid Profile with 
Black Gray

Standard Profile 
with CMYK Gray

Vivid Profile with 
CMYK Gray

Print with color reproduction close to standard color monitors. Use only black to 
reproduce intermediate shades of gray.

Print with more vivid color reproduction. A good choice for line art and graphics. 
Use only black to reproduce intermediate shades of gray.

Print with color reproduction close to standard color monitors. Use the four colors 
of CMYK to reproduce intermediate shades of gray.

Print with more vivid color reproduction. A good choice for line art and graphics. 
Use the four colors of CMYK to reproduce intermediate shades of gray.

Specifies color reproduction and black output for text, graphics and images.
Device Color Space for Text/Graphics/Image1.

Choose On to conserve toner. The overall effect is lighter, so this feature is recommended for test printing or 
producing documents for which appearance is not critical.

Toner Save2.

Color brightness is adjustable. 100% is normal brightness. Brightness darkens as the numerical value 
grows.

Brightness3.
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Miscellaneous Menu (in Printer Features Menu)
Miscellaneous menu is used for configuring Panasonic Printing System associated settings.

1

3

2

1. Secure
Printed documents can be saved on the printer's optional hard disk drive (HDD) if the printer is equipped 
with one. Saved documents can be printed from the printer's control panel. See "Mailbox Printing" on page 
47. Three types of mailbox printing is available.

Note:
Using mailbox printing requires that the optional Hard Disk Drive Unit is installed in the printer.
In order to utilize the mailbox function of the Panasonic printer, the user information must be input prior to installing 
the PS printer driver. The PS Driver Security Utility to change the setting before installing the PS printer driver. For 
more detail, refer to "Operating Instructions (For Setting Up PostScript3 Printer Driver)".

None Mailbox printing is not applied.

Check then Print Allows you to print one proof set, before proceeding to print a large multi-set with 
various settings. The documents data will be deleted from the printer after printing.

Mailbox Saves print data in the printer, in the mailbox specified by the User ID. The User ID 
must be entered to print documents saved in Mailbox. The document data will remain 
in the printer until it is deleted.

Secure Mailbox Saves print data in the printer, in the mailbox specified by the User ID. The User 
ID and Password must be entered to print confidential documents saved in Secure 
Mailbox. The document data will remain in the printer until it is deleted.
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2. Print Blank Pages
Selecting this option will enable printing blank pages.

Note:
The Print Blank Pages is not selectable if the Print on Both Sides is set to be enabled on the Layout menu.

3. Front/Back Cover
 You can configure the settings for cover pages. To use a cover page, select Front Cover or Back Cover, 

specifies the paper source used for pages for the Front and Back covers.
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Printing from Windows Applications
If the printer driver installed properly and is selected as the default printer in the printer setup, printing from any 
Windows application is a simple operation.

To print from most Windows applications, use the Print command in the File menu.

Selecting the Print command typically displays the following Print dialog box:

Setup your preferred configuration (Page Range, Number of copies, etc.) first, and then click the Print  
button to start printing.

While documents are being printed, a printer icon appears in the System Tray near the clock in the bottom right 
hand corner of the screen. The icon disappears when printing is completed.

You may double-click the printer icon in the system tray to open and verify the details of the print queue.

Note:
If more than one printer is installed on your PC, follow the steps below to set a default printer:
1. Click the Start button, select Printers and Faxes icon (for Windows 2000: Click the Start button, select Settings, and 

then click the Printer icon.).
2. Right-click on the desired printer icon, and then select Set as Default Printer in popup menu. The check mark next to 

the printer icon denotes a Default Printer.
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Printing from Macintosh Applications
If the printer driver installed properly and is selected as the default printer in the printer setup, printing from any 
Macintosh application is a simple operation.

To print from most Macintosh applications, use the Print command in the File menu.

Selecting the Print command typically displays the following Print dialog box:

OS 8.6/9.x

OS X

Setup your preferred configuration (Page Range, Number of copies, etc.) first, and then click the Print  
button to start printing.

Note:
If more than one printer is installed on your Macintosh, the printer can be selected by Printer menu of the top of the 
dialog box.
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For OS 8.6/9.x:

 Click the Save Settings  button to save the current settings for the default values.

For OS X:

 Select Save Custom Setting menu to save the current settings for the default values.

 Click the Preview  button to view a preview image of the printout, to check that the print options are set 
correctly.

 Click the Save As PDF...  button to save the print output as a PDF file.

 Click the Fax...  button to apply the changes to the settings and to send a fax.
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Using the Job Status Utility (Windows only)
The Job Status Utility is a utility software that notifies a PC of the status of a print/fax job. This utility is 
convenient for a network printer, as the print/fax job can be observed from a remote PC.

 A popup Completion Notice will display on your PC screen when the Print/Fax job is finished.

 To help you maintain records of the documents you send or print, the Job Status Utility is equipped to list the 
transaction result as a Log file.

Note:
 The Job Status Utility can be used only with the Windows based PC.
 To use the Job Status Utility, IP Address has to be registered first with the PS Driver Security Utility.
 Rebooting the PC is required after the registration of the IP Address on the Windows 9x/Me.
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Using the Job Status Utility (Windows only)
The Job Status Utility software will display a popup Completion Notice on your PC screen when the Print, PC 
Fax, Copy, and Fax jobs are finished.
The information displayed in the Completion Notice vary according to the type of job being performed.

Completion Notice
After a job completes, you will receive a notice similar to the ones shown below on your PC's screen.

Print Completion Notice

mm/dd/yyyy 6:20:17 PM

mm/dd/yyyy 6:20:35 PM

Opens Log window. Opens Setup window.

PC Fax Completion Notice

mm/dd/yyyy 6:29:00 PM

mm/dd/yyyy 6:30:08 PM
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Using the Job Status Utility (Windows only)
Job Status Utility Log

To help you maintain records of the documents you send or print, the Job Status Utility is equipped to list the 
transaction result as a Log file. The latest 100 transactions are recorded on the log.

To start Job Status Utility Log window, click Log  button on the Completion Notice window or 
right-click the Job Status Utility icon  on the taskbar, and then select the Log from the menu.

The Job Status Utility Log window appears.

Note:
When the Job Status Utility icon  is not on the taskbar, select All Programs  
Panasonic  Job Status Utility  Job Status Utility from the Start menu to 
activate the Job Status Utility icon.

NOTE Job Status Utility does not appear if the device is connected with a USB cable.

Refreshes the Job Status Window Opens the Select Printer Window (See Below)

Saves the displayed Log as a CSV format file.
(Only for Completed Job Status)

Deletes the Selected Print Jobs, or 

all Completed Jobs in the Log.

Chooses the printer name to monitor.
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Using the Job Status Utility (Windows only)
Setup

You may set the condition to display the Completion Notice window after the job is completed.

To start Setup window, click Setup  button on the Completion Notice window, or right-click the Job Status 
Utility icon  on the taskbar, and then select the Setup from the menu.

The Setup window appears.

Note:
When the Job Status Utility icon  is not on the taskbar, select All Programs  Panasonic  Job Status Utility 

 Job Status Utility from the Start menu to activate the Job Status Utility icon.

1. Display Condition
 Selects the condition to display the Completion 

Notice window.

2. Display Completion Notice in front.
 Specify whether the Completion Notice window 

is displayed on the front of other windows.
 When this option is not selected, the Completion 

Notice window is displayed in the back of other 
windows. When the Completion Notice is 
displayed, the  icon on the taskbar blinks.

 Click the  icon to bring the Completion 
Notice to the front.

All Always display after each 
transmission.

Error only Displays only when an error 
occurs.

None Do not display.
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Using the Job Status Utility (Windows only)
Information displayed in the Completion Notice and the Job Status Utility Log. (See page 44)

Status Indicates the status of the job. (Completed, canceled, etc.)

Error Indicates the error information if available. (Information code, error message, etc.)

Type Indicates the type of the job. The Completion Notice is used in common with PC Fax 
job, PC Print job, Copy job, and Fax job (Sent from the device).

File Name Indicates the PC printed file name.

Page(s) (Print) Indicates the number of pages of PC Print job, and Copy job.

Page(s) (Fax) Indicates the number of pages of PC Fax job, and Fax job (Sent from the device).

Start Time Indicates the start date and time of the job. The format of the date and time depends on 
the Windows setting of your PC.

Finish Time Indicates the completion date and time of the job. The format of the date and time 
depends on the setting of Windows of your PC.

Duration Time Indicates the duration time of the job. (hh:mm:ss)

Fax Number/Email 
Address

Indicates the Fax Number, or Email Address (Fax job only) of the Fax transmission.

Destination Name Indicates the registered Destination Name in the Fax driver's Phonebook when using 
the Phonebook of the Fax driver to transmit a document.

Device Name Indicates the Device Name registered in the device that is used for the Fax transmission

Device Location Indicates the Device Location registered in the device that is used for the Fax 
transmission.

Device IP Address Indicates the Device IP Address that is used for the Fax transmission.

User Name Indicates the Department ID of the current running job.

Machine Name Indicates the Computer Name / IP Address of the current running job.



Mailbox Printing
Printed documents can be saved on the printer's optional hard disk drive (HDD) if the printer is equipped 
with one. Saved documents can be printed from the printer's control panel. Three types of mailbox printing is 
available.

Secure Mailbox:
Saves print data in the printer, in the mailbox specified by the User ID. The User ID and Password must be 
entered to print confidential documents saved in Secure Mailbox. The document data will remain in the printer 
until it is deleted.
The PS Driver Security Utility adds User ID, Password, and Department Code information to print data that is 
printed using the PS Driver. This utility allows users to take advantage of the print job statistics, security and 
other advanced Panasonic printer functions.

Mailbox:
Saves print data in the printer, in the mailbox specified by the User ID. The User ID must be entered to print 
documents saved in Mailbox. The document data will remain in the printer until it is deleted.

Check Then Print:
Allows you to print one or more (can be adjusted on the device's control panel) proof set, before proceeding to 
print a large multi-set with various settings.
The User ID must be entered to utilize the Check Then Print function.
The documents data will be deleted from the printer after printing.
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Mailbox Printing
Using PS Driver Security Utility

Note:
For Windows 98/Me:
When the setup is completed, a message is displayed prompting you to restart your PC. Click the OK  button 
to restart your PC. After rebooting your PC, re-configure the Device Options Tab settings because the default settings 
are restored.
For Macintosh:
In order to utilize User ID, Password and Department Code, the appropriate information must be input prior to installing 
the PS printer driver. The PS Driver Security Utility to change the setting before installing the PS printer driver.

 If you have already installed the PS printer driver, uninstall it, change the setting using the PS Driver Security Utility, 
then install the PS printer driver.

 If you want to change User ID, Password or Department Code after it begins to operate the printer, uninstall the PS 
printer driver, change the setting using the PS Driver Security Utility, then install the PS printer driver again.

Double-click the PS Driver Security Utility icon on your desktop.

The PS Driver Security Utility window will appear.

Enter the following information.

Printer
Select the printer.

User ID
Input the user ID (8-digit number maximum) to be used for Check Then Print, Mailbox, or Secure Mailbox.

Password
Input the password (4-digit number) to be used for Secure Mailbox.

Department Code
Input the department code (8-digit number maximum) to be used by the accounting manager.

Click the OK  button.
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Mailbox Printing
Saving a Print Job (from a PC)

Select Print in the File menu of the application software, and click Properties.

Select Check Then Print, Mailbox or Secure Mailbox in Secure setting in the Advanced 
Settings of the PS Printer Driver.

Note:
Refer to "Configuring the Printer Driver Settings" of your OS for Secure setting.

(For Windows 9x/Me)
In the Device Options Tab, select Secure in the Printer features. Then Check Then Print, Mailbox, or 
Secure Mailbox can be selected.

Click the Print  button to save the document data. The first proof set will start printing if Check Then 
Print is selected.

(For Windows XP / 2000)

(For Windows 98 / Me)
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Mailbox Printing
Printing or Deleting Mailbox Data

Press the Print key if set in other function mode.

The total number of saved jobs in each mailbox 
is displayed.
Select the desired mailbox.

Print display appears on the printer control panel.
Enter the mailbox user ID number (up to 8-digit).

Select the OK  button.

The display shows the saved print jobs in the 
selected mailbox.
Choose the job you want to print, and select the 

Print  or Delete  button.

Select All  button Selects all print jobs. 
(Mailbox only)

Close  button Closes the mailbox 
display.

Check Then Print:

Mailbox:

Note:
If there are only 1 saved job for the user, Mailbox 
selection screen is not displayed (Skip to 5).
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Secure Mailbox:

Secure Mailbox only
Password display appears if Secure Mailbox 
is selected.
Enter the Password, and then select the 

OK  button.

Mailbox or Secure Mailbox
Select whether to delete the print job after 
printing.

Check then Print only
The number of copies is displayed.
Enter the number of copies and select the 

OK  button to start printing.

Note:
After having finished printing the Check Then Print 
job, it will be removed from the printer's hard disk 
drive.
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Job Control (Output Queue)
The Job Control menu of the printer control panel contains four buttons with the following functions.

On Line  button

Off Line  button

Cancel Print  button

Output Queue  button : Checks the current print jobs.

: Stops the current print job and deletes the job from the output queue.

: Turns the printer off-line.

: Turns the printer on-line.

This section describes how to use the Output Queue  button to perform operations on the print jobs in the 
output queue.

Select the Output Queue  button.

Print display appears on the printer control 
panel.

Select the Job Control  button.

Press the Print key if set in other function mode. Displays a list of all pending output jobs that are 
usually processed on a first come first served 
basis. 

Select the Print  tab.

Enter the password (4-digit), and then select 
the OK  button.
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Displays a list of current and pending Print 
jobs. Select the print job you want to manage, 
and choose one of the following tasks to 
perform.

Select All  button Selects all print jobs.

Delete  button Deletes the selected 
job from the Output 
Queue.

Priority  button Set or change the 
printing order of the 
selected job(s) in the 
Output Queue.

Close  button Close the Output 
Queue display.
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Specifications

Specifications
Printing Speed DP-C262 : 26 sheets/minute : Black and White

21 sheets/minute : Color

DP-C322 : 32 sheets/minute : Black and White
21 sheets/minute : Color

(A4/Letter size, Plain paper from Paper Tray, 600dpi, Simplex printing)

(A4/Letter size, Plain paper from Paper Tray, 600dpi, Simplex printing)

Resolution 
(dots per inch)

600 x 600, 1200 x 1200

Interface USB 2.0
Ethernet (10Base-T/100Base-TX)

Printer Language Adobe® PostScript® 3™

Fonts 136 Typeface fonts

Supplied Printer 
Driver

Windows 98, Windows Me, Windows NT 4.0 (With Service Pack 3 or later is required), 
Windows 2000, Windows XP, Windows Server 2003, Macintosh OS 8.6/9.x, Macintosh 
OS X 10.x

Operating System 
Support

Windows 98, Windows Me, Windows NT 4.0 (With Service Pack 3 or later is required), 
Windows 2000, Windows XP, Windows Server 2003, Macintosh OS 8.6/9.x, Macintosh 
OS X 10.x

Network Printing 
Protocol Support

LPR, IPP, SMB, Standard TCP/IP Port Printing (RAW/LPR), NetWare, AppleTalk
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Printing Operation Failure
If the printing operation fails, check the following items first:

 The connecting cable (USB or Ethernet LAN cable) is properly connected.
 Power of the device is turned ON.
 Paper is loaded properly in the device.
 An error message is not displayed on the device. (See Note)

The above points can be verified by printing a test page. Refer to OS manuals, help topics, and/or Online 
Support for the procedures on test page printing.

NOTE The status of the devices can be verified by the Device Monitor.
Refer to the Operating Instructions (For Device Monitor).
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Documents Not Printing Correctly
Problem Possible Cause / Solution(s)

Incorrect printing position or print is 
missing at the edge.

Paper size or printing orientation is different between the 
application settings and the printer driver settings - Specify the 
settings again.
The specified paper has not been loaded into the device - 
Check the settings again or load the appropriate paper.
The document margin is not sufficient.

Characters and symbols not used in 
documents are printed.

Verify that the correct machine has been selected by users as the 
printer driver.

Printing operation takes excessive time. The wait time for printing operations depends on the spool settings.

Although print data is transferred to the 
device, it is not printed.

Printing stops in the middle of the run.

Document is not printed from the 
Multi-Purpose tray (Sheet Bypass).

Make sure the printer is Online.
Make sure the USB printer cable is connected properly.
Restore the power if the On line LED is Off even if the USB 
printer cable is connected.

Check whether there is a Network problem.

Verify the Paper Size set to the Multi-Purpose tray 
(Sheet Bypass).
Set the Paper Size as the following procedures.

1. Press the Copy  key.
2. Select "Paper/Output Tray".
3. Select "Change Size/Media".
4. Select the paper size and select "OK".
Note:
Select "Auto" on step 4 if the following paper size is loaded on the 
Multi-Purpose tray (Sheet Bypass). The Paper Size is automatically set 
properly.

For USA and Canada users : Ledger, Ledger, Letter, Invoice
Except for USA and Canada users : A3, B4, FLS, A4, A5

Document is not printed correctly, and 
the following message is printed out 
instead.
"This job contains Binary Data, but 
your printer requires a special driver 
setting to receive binary data on this 
channel."

Verify that the Output protocol in the Device Settings is set to 
ASCII.
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Error Messages Displayed on the Computer
Problem Possible Cause / Solution(s)

Error writing to USB.
Unable to write to the Specified device.

Verify that the device is connected to the computer correctly.
Verify that the power of the device is turned On.

Error writing to USB.
Printer timeout error occurred.

Verify that the power of the device is turned On.
Excessive data volume or number of pages may overflow the 
device's memory, disabling data reception.
Increase the timeout setting value in properties (for transmission 
retry).

Printing is disabled due to an error in 
the current printer settings.

Differences in settings such as paper size or printing orientation 
exist between the application and the printer driver.
Correct the settings.
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Solution(s)

Error Messages Displayed on Your Machine
If a document is not printed out, an error may have occurred.From the error messages displayed on the Control 
Panel, it is possible to know what caused the problem, and how the problem can be taken care of. 

Checking Error Messages: Press the Print key, select the Job Control  button and the Output Queue  button.

Then, select the Print History  tab. The error message(s) are shown on the Status column.

Once you know the error message, check below for the cause and solution for the error.

Error Messages Possible Cause

Print Parameter Error(001) The Duplex Unit does not 
function properly.

Contact to the Panasonic Authorized Dealer to 
maintain your machine.

Print Parameter Error(002) Specified a Paper Source 
which is not installed on 
your machine.

 Verify the Installable option settings correctly on 
your printer driver.

 Verify the Number of Paper Tray settings 
correctly on your printer driver.

Print Parameter Error(004)
Print Parameter Error(005)

Specified the Output Tray 
to Finisher. However, the 
Finisher Unit is not installed 
on the machine.
Specified the Sort Method 
to Shift, or specified the 
position of the staple.

 Verify the Installable option settings correctly on 
your printer driver.

 Verify the Finisher settings correctly on your 
printer driver.
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Printer Parameter Error(125) Specified to staple 
documents of different 
document sizes.

 Cancel Staple, and try print again.

Print Parameter Error(126) Specified to Punch 
documents of different 
document sizes.

 Cancel Punch , and try print again.

Print Parameter Error(006) Specified the hole punch 
position. However, the 
Punch Unit is not installed 
on the machine.

 Verify the Installable option settings correctly on 
your printer driver.

 Verify the Punch Unit settings correctly on your 
printer driver.

Print Parameter Error(101) Specified a Paper Source 
unable to print in Duplex.
(Duplex printing is not 
possible from the tray 
set with A5 in Landscape 
format)

 Specify the tray set with the A5 in portrait format.
 Select Automatically Select on the Paper 
Source menu.

Print Parameter Error(104) Specified a Paper Source 
unable to shift sort.

- Only when 1 Bin Finisher 
(DA-FS320) is in use.

- It is not possible to shift 
sort with B5 in portrait 
format. 

 Specify the tray set with the B5 in Landscape 
format.

Print Parameter Error(106)
Print Parameter Error(107)

Specified a wrong Paper 
Source when printing a 
document with stapling.

 Verify the Installable option settings correctly on 
your printer driver.

 Verify the Finisher settings correctly on your 
printer driver.

 Select Automatically Select on the Paper 
Source menu.

Error Messages Possible Cause Solution(s)

Print Parameter Error(108)
Print Parameter Error(109)

Specified a wrong Paper 
Source when printing a 
document with punching.

 Verify the Installable option settings correctly on 
your printer driver.

 Verify the Punch Unit settings correctly on your 
printer driver.

 Select Automatically Select on the Paper 
Source menu.

Print Parameter Error(119) Specified a wrong Media 
Type when printing a 
document with Rotate 
sorting.

 Verify the Media Type setting on your machine.
 Select the same media type on the printer driver 
as set on your machine.
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Printing Area
When printing to the device, there is a non-printable margin on all 4 sides.

Less than 4 mm 
(0.16")

Top
3 mm - 5 mm 
(0.12" - 0.20")

2 mm - 6 mm 
(0.08" - 0.24")

Bottom

Less than 4 mm 
(0.16")

Unit: mm (inches)
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PANASONIC DIGITAL DOCUMENT COMPANY MAKES NO WARRANTIES, GUARANTEES OR 
REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH RESPECT TO 
THIS PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC DIGITAL DOCUMENT COMPANY ASSUMES NO RISK AND SHALL NOT BE SUBJECT 
TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS SUSTAINED BY THE 
CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS PANASONIC MACHINE. SEE 
YOUR DEALER FOR DETAILS OF DEALER’S WARRANTY.

USA Only

WARRANTY

For Service, Call:

Panasonic Digital Document Company,
Unit of Panasonic Corporation of North America
Two Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for
USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://www.panasonic.co.jp/global/

T0905-0
PJQMC0557ZA
September 2005
Published in Japan
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